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Back on Track —
Recovering Lost
Revenue

RoboVet




covetrus

e e This guide will go through a refresh on
ey T — how to run a report to assist with
s ZonEuer - identifying loss of revenue that may have
Security Permissions Dave T vl name: \gal Mehenziz . .
w e M??Ti"y?s. . ] been caused during the period of
Clinical James Collins Passwords & Repots ———————————————————— |Ode0Wﬂ
:tc:cu;nts jg:‘ﬂmawta “ou are using Emplayes Codes to lagin. You da not ne
Application Setup Joki Brown e
e Nia e Rese ey [izion ] e Ensure that the user running this report
has a security level of Medium.
(g Cronee e Srnaney e Click the RoboVet icon and select All
o Reports.
‘Windows Calculator
Run Reminders
Customise This View
o
Referring Practices
RoboVet Documents
Run ...
View Object Locks
e o e Click the Client tab.
e e Select Client Products Sold and Not
List Scheme Members llows you to report on scheme memberships and renewals [SMS enabled) Sold (ThIS Should be hlghllghted by
default)
e Double click the report or click Run.
e Select Grid View and click Next.

to Microsoft Word ar SMS

Robo

Displays results in a grid on your screen
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List Product Sales Filters

= Erish
Client Type [
Client Aletts <¢Back
Debt Severly ]

S cheme Membershin
Home Surgery (7
[

Arimal Species [
Animal Age [ALL AGES)

Ciients Inactive (No)

Deceased Animal Sales (Mo

Inciude Sales Infomation (No)

Product Sale Selection

Allowed 1o be Sent Markelin Test Messaces (Ves Nol

o
o

covetrus

A list of options will appear.

Client Type [*]

Drebt Severity (4]

Scheme Membership

Home Surgeny [*]

Animal Type [*]

Animal Species [7]

Animal Age [FALL AGESY)
Clierts Inactive [Ma]
Deceaged Animal Sales [Ma)

CONTIMUE ﬂ Finish
Client Alerts << Back

The product sales selection is the
minimum required to have some data
produced in a report, filtering the options
will give a more detailed targeted report.

Client Type [*]

Clignt &lerts

Debt Severity ()

Scheme Membership
Home Surgem [*)

Arimal Type [7]

Arirnal Species [7)

Animal &ge [FALL AGESY)
Clients Inactive [Ma)
Deceaszed Animal Sales (Mo)

I
Product Sale Selection

Alloweed to be Sent Marketing Text Messanes [Yes Mol ﬂ

CONTINUE Bl

Change Include Sales Information to
show the descriptions of the items in the
report.

This is useful when including more than
one type of product in filters screen.

For example, all pack sizes of a product
or versions of a medication that could be
used for any certain condition.

Double click.

. Select
Cancel

Select Yes.

COMTIMUE ﬂ Finish

Client Type [¥]
Client Alerts < Back
Debt Severity 7]

Scheme Membership

Hame Surgery [¥]

Animal Type [¥]

Animmal Species [7)

Animal Age (AL AGES®)
Clients Inactive Ma]
Deceased Animal Sales (Ma)

Product Sale Selection
Allowed to be Sent Marketing Tewt Messages Ves Mol j

The Includes Sales Information has
now been changed.
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CONTINUE -
Client Type %]

Client Alerts

Diebt Severity [7]

Animal Type [¥]

Apirnal Specias [*)

Animal Age [*ALL AGES)

Clients Inactive [Mo)

Deceased Animal 5 ales [Ma]

Include Sales Infarmation [Yes]

Product 5 ale Selection

Allowed to be Sent Marketing Text Messages MesNaol

<< Back

Finish |
[

covetrus

Scheme Membership is another valued
filter to use as this will show clients who
have purchased items on a scheme and
have not returned for repeated sales.

Double click Scheme Membership.

Select Members [Members, Mon-tembers)
Schemes [*4LL SCHEMES®)

B |

Mest »»

<¢ Back

Click Select Members and then choose
whether they are a member of a scheme
or not.

Click Schemes.

B0 sales Discount
Long Term Medicine

| @
| o0e Breeder Discount
{ L

New Scheme 11

Sell stock at Cost Services 507 Discount
Healthy Pet Club

Vaccination for Life
Internet Farm Drugs
Stock 10% Services 5%
Guide Dogs

Surcharge for slow papers

Robo

1 object(s] selected huitiSelect

Mest >>

¢ Back ‘

Choose which schemes you want to be
included on the report then click Next.

List Product Sales Filters

Home Surgery (%)

Animnal Type (7]

Apimal Species [7]

Animal Age [ALL AGES®)
Clients Inactive [Mo]
Deceazed Animal Sales (Na]
Include Sales Information [Tes)

Hon
Allowed to be Sent Marketing Text Meszages [Yes,Ma|
Allowed to be Sent Marketing Email [Yes Mo]

Alloveed to be Sent Marketing Post [v'es.Ng
a5 Emal [Yes Mol

= Einish |

Has Mobile (s, Mol :I

<< Back |

Finish entering filters

Robo

Other options that should be used to filter
the report are the marketing preferences.

If sending by email, double click Allowed
to be set Marketing Email.
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| s | e Select Yes.
Cancel
e e [ 2l e | e Do the same for the Has Email filter.
Arimal Species 7] |
A::::I AZZCELEASLL AGESY) Bk
Clients Inactive [Ma]
Deceased Animal Sales [Ma]
Include Sales Information [Y'es)
Product Sale Selection
Home Sungar (] ElNES ¢ If you would like to filter by a specific
Animal Type [* . . . .
I ——— - animal, double click Animal Species.
Animal Age (AL AGES) =
Clients Inactive [Mo]
Deceazed Animal 5ales [No]
Include Sales Information [Yes)
Product Sale Selection
Allowed to be Sent Marketing Test Messages [Yes, Na)
Allowed to be Sent Marketing Email [Yes)
Allowed to be Sent Marketing Past [Y'es Ma)
Has Email [Yes]
Has Mobile [YesNa) j
; ;
e Type the species into the box.
5[ yp P
® LCancel . .
e An *in front of the name will search for
any combination of those letters in the
o Enter Animal Species to repart on clients only with animals of this species .
0 species name.
Q
[0’
e If you are setting the age of the animal,

Scheme Membership
Home Surgery [1]
Animal Type [*]

Animal Species (*Felineg]

Clients Inactive (Mo)

Deceased Animal Sales (Mo)

Include Sales [nfarmation [Tes|

Product Sale Selection

Allowed to be Sent Marketing Test Messaaes Mes. Nol ﬂ

Specify the animal age
Animals with an unknown DOB are not included [(“ALL AGES )

COMTINUE - Firish |
Client Type [*]

Client Alerts <¢ Back |
Diebt Severitp %)

note that the age is for the current date,
not the date at the time of the sale.
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‘Years Months ~ Days
(] L] L]

LCancel

Lowest animal age to include (youngest]

covetrus &

Pick a starting age.

~hg

Years  Months  Daps
10 (i3] [

Highest animal age to include [eldest]

Cancel

Pick a maximum age that you want to
see.

CONTINUE

Client Type: (]

Client Alerts

Debt Severity [
Scheme Membership

Home Surgery )
Animal Type [%)

Deceased Animal Sales [No]

Include Sales Information (Ves)

PFroduct Sale Selection

Allowwed o be Sent Marketing Text Messanes [Ves. Nal

-l

Specify the animal age

Animals with an unknown DO are not included (00.00.00 to 10.00.00)

Einish
<< Back

The age range is for the current date. If
you want to include animals who were
10years, but you're looking at sales 6
months ago then ensure the age range is
10 yeas 6 months, otherwise it would
only list animals up to a maximum 9
years and 6 months.

CONTINUE

Clignt Type [7)

Client Alerts

Dbt Severity [

Scheme Membership

Horme Surgery [*]

Animal Type [1]

Animal Species (Feling)
Animal Age [00.00.00 to 10.00.00)
Clignts Inactive [No]
Deceased Animal Sales [No]

Al e

<< Back

Select the Product Sale Selection
option and click Finish.

(&3 Products Sold Selection

Avallable Products Sold
Lah Charges: Kidney &Urine Profile ﬁl From
5 Lts Hibiscrub Add > F oo =]
Achromycin Oint 3% T
Add All>>
Aop Inj 10mg ] To
ACP Inj 10ma/ Remove ¢ L ez
ACP Ini 2mg/ml
ACP Tabs 10mg lencxeR1iCd
ACP Tabs 25mg
Adcortyl Orabase
Adequan Intra Muscular
Adrenal Inj 110000 110ml by
Adrenaline Irjection 1-1000 Not Seld
Advartage 100 For Dogs 4's From
Advantage Lge Rabbit+cat 4's
Advartage Rab+oatrdog 0. drkd’ Add > M [omarzozn +
Advice Charges AddAll>> i
Advocate Lge Cat 80 4-8kg 3 pipette
Advocate Lge Dog 25 10-25k 3 pipete Remave ¢ M [30marz0z0 +
Advacale Med Dag 10 410K 3 pipette Fremove All <<
Advocate Med Diog 40 410k 6 pipette
Advocale Smi Cat 40 <4kg 3 pipetie
Advonate Smi Cat 40 <dkg & pipstie =l
~Product Fikers———————————————
Product Hame:
& Service and Stock
" Service
Clear
€ Stack - 2z
oK Cancel

The selection screen by default, shows
all products in your database.

These are a mix of stock and service
items displayed in alphabetical order.

In the Product Filters section, choose
the stock or service options and you can
enter an individual product name as
needed.

Page 5 of 9



covetrus

&{3Pruducts Sold Sefection

P o F e Enter a product name in the box and
mrerti Pfares click filter to display the items you want

F i3] to search for.

0
g 40 bk 3 pipstis
1540 25405 3 pipette

" Dag 40 2540k pipelle

o e Once Filter is clicked the list will instantly

| g hide all items that don’t match.
[ Vrzﬂw«zm -
Hemave 21

Froduct Fiees

Frodet Hame
advcate

e
SED oK Cencel

@ Gervice and Stack |
" Senviee

G Products Sold Selection

¢ Highlight the items you want and click
* sl Add to transfer them into both the Sold

Add 2l > Ta

P v 2] and Not Sold sections.

!

fed Dog 10 410k 3 pipetle

3 pipette

Advacate K] Dog 40 2540k 3 pipetie
Advocate XI Dog 40 25-40kg 6 pipstte

Not Sold
From
| Add> ¥ [or0a/2020 =
Add Al > To
Fenioe ¢ W [a0/0a/2020 =
Plenave Al

[~ Produet Fiters———————————————
Broduct Hame
@ Senvice andStock [

s
- e Clear | _Fiter
Stock

3 Cancel

&Products Sold Selection

e You can add or remove items as you
Available Products Sold R
Advocate Lge Dog 25 10-25k 3 pipette Advocate Loe Cat 80 4-8ka 3 pipette From
Advocate Med Dog 10 410k 3 pipette Addy Advocate Smi Cat 40 <4kg 3 pipette IFIW, need to The SeCtlonS do nOt need to
Advocate Med Dog 40 4-10k E pipetie Advocate Sml Cat 40 <4kg 6 pipette h
Advocate Sl Dog 40 <dkg 3 pipette To m a.tC .

Advossts ¥ Dog 40 2540k 3 pipetts Fiemove < W i3z =]
Advocate X Dog 40 25-40kg 6 pipetts
Remove All <

Add Al 5>

e Change the dates for both sections.

Not Sold
Advocate Lge Cat 80 4-6kg 3 pipelie

s ¢ In this example, it’s looking for all sales

fd > Advocate Sml Cat 40 <4kg 6 pipette W [ot/a4r2020 =

o between 1% January and 31 March
B "l 21 2020 and who has not been back and
repeated the sales from 15t April till 19™
T P — May.

Product Name.

 Service and Stack [ o
advocate

" Service

P Clear | Filter

ID_Kl Cancel [ ] CI|Ck OK

List Product Sales Filters

o |mimma o Once_ all your fiIt(_-:-rs a_re_set, highlight
oge |l T Continue and click Finish.

Debt Severity 7]

Scheme Membership

Home Surger (1

Animal Type (]

Animal Species [*Feline)

Animal Age [00.00.00 to 10.00.00)
Clients Inastive [No)

Deceased Animal Sales (No)
Include Sales Infomation [Yes)
Product Sale Selection

Allowed to be Sent Markefing Text Messages [Ves. Nol E

Finish entering fters
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e This will display the report.
Last Name  FrstName  Ttie Company Nome | Address. Chent Type | Chent Home Surgery _ Home Phone _ moblke Anmsl Name  Consutaton Dste Product Sod
Andrew Jean Mrs. |38 Nicholson Rosd |3 Equine | Liiput 01472 884963 | 07866566665 | Serendipty | 010172020 145200 | Advocate it 40 <dkg 3 ppette.
S T g
e e e R

& Clients Sold Products 01/01/2020 to 21/03/2020 And Not Sold Products 01/04/2020 to 19/05/2020 e Hide any unwanted columns by right-
File Display Edit . . . .
Last Name | First Name |Title |Company N '~ ** = Postcode | Client Type |C CIICkIng the column and SeIeCtmg Hide
Total Celumn CO|Umn.

Collins James Hide Column 3 Equine Li

e Clients Sold Products 01/01/2020 to 31/03/2020 And Not Sold Products 071/04/2020 to 19/05/2020

e Change the order of the columns by
e e — S clicking and holding the top of the
column and drag it to the new location.

137 Mr  James

@ Clients Sold Products 01/01/2020 to 31/0:

Fic| iy ot e To save the layout of the report, click
B File then Save Format.

Print...

Print Preview...

Print Selected...

Print Preview Selected...
Page Setup..

Printer Setup...

Load Format...

Load Format From File...

Bxit

e e Name the report something which will be
Nao  [rems S0 -Teekone Lt DT memorable and give it a description.

oK

Description  [Riaport contains telsphone numbers only

=]

@ Clients Sold Products 01/01/2020 to 31/0;

Fie Doy e e To load the report format, click File then

- B Load Format.

Print...

Print Preview...
Print Selected...

Print Preview Selected...
Page Setup...

Printer Setup...

Save Format...

Load Format From File...

Exit

— e Choose the desired format and click OK.
oK
Cancel

Repoit contains telephons numbers only
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@ Clients Sold Products 01/01/2020 to 31/03/2020 And Not Sold Products 01/04/2020 to 19/05/2020

covetrus

= e To print the report, click File then Print.
Export > To Excel Spreadsheet... plation Date
Print... To Comma Separated File (CSV)... N Lo i
e To Tet .. e The report can be exported to a CVS file
Print Selcte. for further analysis.
Print Preview Selected...
Page Setup...
Printer Setup...
Save Format...
Load Format...
Load Format From File...
Exit
End Report Choice | e Once the report has been run and
exported then closed, you will be
Exit Report presented with the following options.
_ e You can run the report again if you need
Run Report Again to change any filters.
. e Save report allows you to store the
Save Report Choices . .
report using the format presented in the
preview.
e Give the report a suitable name.
Name Advocate Sales Cat
el L e Add a description and ensure to add a
**Remember to Change Date range™* Cancel note to Change the dateS
lSaveafolmalwilhthesechoices v I . .
TR e Ensure to tick Save a format with these
choices.
Repoart contains telephone numbers only
RoboVet Reports e The saved report will then be shown
Znimal | Clhent | Consultation  Financial  Stock below the orlglnal report by CIICkIng on
the +.
= Client Produc And Mo
L Bdvocate Sales Cat
e To report on an individual scheme, click
Insurance Schemes Digital Imaging Busin SChemeS in the ribbon bar-
™ G New Adjustment | [] Current e These can be Schemes that can be
. 8 ¥ Change Expired All Char_geable_ or not. . .
Hew MW Remove Debt Only e Any item billed to a client or patient on a
 Charge Show scheme is stored in this useful report.
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/@', Change User Exit Robovet s
(o30) o (]

o)
S/ cients  Poductlst  Orders

covetrus

Select the Scheme you wish to view.

e This will default to the current animal
selected.
3l Imaging Business Barometer Visits TO ShOW a" anlma|S, C“Ck A” C|IentS
| Current Removed

Expired All Clients q

Debt Only All Clients
she Current Client
| ddress | Start Current Animal rr
nsurance Schemes Digital Imaging Business Barometer  Visits

g gl';, fi New Adjustment | V| Current Removed | Scheme Usage
% RE 9 change

Expired All Clients ~

w New _
e Pay Remove Debt Only
Charge Show View
"[Cient [Arimal |Breed | Address | Start |End | &uto Renewed | Scheme Debt| On Hold
| Andiew  Cody Cavalier King Charles Spa 38 Nicholson Road  01/08/2019  31/07/2020  Nao £0.00 Mo
Andiew  Eclipse  Bumese 38 NicholsonFRoad  01/08/2019  31/07/2020 Mo £0.00 Mo
Grainger  Nicky  Collie (Rough) 99 Carlton Crest 13/05/2020 12/06/2021 Mo £0.00 Mo

Malpas  Max Domestic 16 Dene Road 13/05/2020 12/05/2021 Mo £0.00 No
Morison _Pongo  Dalmation 17 Dene Garth 13/ o

£0.00 No

This will display the grid view of all
clients matching that scheme.

Select the client you want to view and
click on Scheme Usage in the View tab.

Scheme Usage for Healthy Pet Club - Jean andrew - Cody

[ ipply| Limit| Coneult Date | Product Savings Exc. VAT
Line 0 used (unlmited NoSales Vet n/a
Line 101 30/03/2013 11:19 Vaccinate Dog Booster [FOC HPC) £35.00
oy 10F2 0171172019 1203 n M £2180

Oy 10f2 30/03/201311:13 2641
n'a

n'a

Oy 0used unlimited)
Oy 0used urlimited)

The Scheme Usage pop-up will appear.
It shows what the client has used from
their scheme.

The benefits are detailed along with the
limits on items or services.

The mount of discount given is also
displayed.

The Consultation date, time and items
are displaye in date order.

The savings are useful to explain to any
clients who may be thinking of leaving
the scheme due to lack of use, on how
much they have already saved.

To give a copy of this report to a client,
hold CTRL and the Print Screen key on
your keyboard.

This will copy the image into the
clipboard so you can paste it onto a
practice document.
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